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APPENDIX 2 

 

Vector properties dialog 

 

Below, a brief explanation of each tab is provided. In the course of this GIS 

training will go explaining more in depth and making use of the functionalities of 

some of these layer properties. 

 Style tab. Enables us to change the symbology of features included in the 

vector layer. There are three types of symbols: marker symbols (for points), 

line symbols (for lines) and fill and outline symbols (for polygons). Symbols can 

consist of one or more symbol layers. It is possible to define the colour of a 

symbol and this colour is then defined for all symbol layers.  

 

 

 Labels tab. The  Labels core application provides smart labeling for vector 
point, line and polygon layers and only requires a few parameters. This new 
application also supports on-the-fly transformed layers. The core functions of 
the application have been redesigned. In QGIS 2.0 there are now a number of 
other features which improve the labeling. The following menus have been 
created for labeling the vector layers: text, formatting, buffer, background, 
shadow, placement and rendering 

http://www.qgis.org/en/_images/mActionLabeling.png
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 Fields tab. The field attributes of the selected dataset can be manipulated.  

The buttons    and   can be used, when the dataset is editable  . 

Within the Fields tab you also find an edit widget column. This column can be 

used to define values or a range of values that are allowed to be added to the 

specific attribute table column.  

If you click on  button, a dialogue opens, where you can define different 

widgets; line edit, classification, range, unique values, file name, value map, 

and so on. 
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 General tab. It is essentially like that of the raster dialogue. There are several 
options available, highlighting; i) change the display name of the layer, ii) set a 
display field to be used for the Identify Results dialogue, iii) Update 
Extents information for a layer and, iv) view or change the projection of the 
specific vector layer, clicking on Specify CRS. 

 

 Metadata tab. Contains general information about the layer, including specifics 

about the type and location, number of features, feature type, and the editing 

capabilities. The Extents section, providing layer extent information, and 

the Layer Spatial Reference System section, providing information about the 

CRS of the layer. This is a quick way to get information about the layer. 
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 Action tab. Provides the ability to perform an action based on the attributes of 

a feature. This can be used to perform any number of actions, for example, 

running a program with arguments built from the attributes of a feature or 

passing parameters to a web reporting tool. Actions are useful when you 

frequently want to run an external application or view a web page based on 

one or more values in your vector layer (e.g. Python script).  

 

 
 

 Join tab. Allows you to join a loaded attribute table to a loaded vector layer. 

As key columns you have to define a join layer, a join field and a target field.  
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 Diagram tab. Allows you to add a graphic overlay to a vector layer. The current 
core implementation of diagrams provides support for pie charts, histograms 
and text diagrams. The placement of the diagrams interacts with the new 
labeling, so position conflicts between diagrams and labels are detected and 
solved. In addition to chart positions can be fixed by the user‟s hand. 

 

 
 

Raster properties dialog 

 

 Style tab. QGIS offers four different render types. The renderer chosen is 

dependent on the data type. 

1. Multiband color - if the file comes as a multi band with several bands (e.g. 
used with a satellite image with several bands). 

2. Paletted - if a single band file comes with an indexed palette (e.g. used with a 
digital topographic map) 

3. Singleband gray- (one band of) the image will be rendered as gray, QGIS will 
choose this renderer if the file neither has multi bands, nor has an indexed 
palette nor has a continous palette (e.g. used with a shaded relief map) 

4. Singleband pseudocolor - this renderer is possible for files with a continuous 
palette, e.g. the file has got a color map (e.g. used with an elevation map) 
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 Transparency tab. QGIS has the ability to display each raster layer at varying 

transparency levels. Use the transparency slider to indicate to what extent the 

underlying layers (if any) should be visible though the current raster layer. This 

is very useful, if you like to overlay more than one raster layer. This will make 

the look of the map more three dimensional. 

 

 

 General tab. Displays basic information about the selected raster, including the 

layer source and display name in the legend (which can be modified). This tab 

also shows a thumbnail of the layer, its legend symbol, and the palette. 
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Additionally scale-dependent visibility can be set in this tab. Also the 

coordinate reference system (CRS) is printed here as a PROJ.4-string.  

 

 

 Metadata tab. Displays a wealth of information about the raster layer, 

including statistics about each band in the current raster layer. This tab is 

mainly for information. You cannot change any values printed inside this tab.  

 

 Pyramids tab. Large resolution raster layers can exhibit a slow navigation in 

QGIS. By creating lower resolution copies of the data (pyramids), performance 
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can be considerably improved as QGIS selects the most suitable resolution to 

use depending on the level of zoom. 

 

 
 

 Histogram tab. Allows you to view the distribution of the bands or colours in 

your raster. It is generated automatically when you open Histogram tab. You 

can choose which bands to display by selecting them in the list box at the 

bottom left of the tab. 
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What‟s new in Quantum GIS 2.0.1-Durfour? 

QGIS 2.0.1 version contains new features and extends the programmatic interface 
over QGIS 1.8.0. We recommend that you use this version over previous releases. 

This release includes hundreds of bug fixes and many new features and 
enhancements that will be described in QGIS manual 
(http://www.qgis.org/en/docs/user_manual/index.html). Also compare with the 
visual change log at http://changelog.linfiniti.com/version/1/. 

We have made a selection of the most meaningful enhancements of this version. 

User Interface 

 New icon theme: It has been updated the icon theme to use the „GIS‟ theme 
introducing an improved level of consistency and professionalism to the QGIS 
user interface. 

 Side tabs, collapsable groups: It has been standardised the layout of tabs and 
introduced collapsible group boxes into many of its dialogs to make navigating 
the various options more easy, and to make better use of screen real estate. 

 Soft notifications: With the new notification system QGIS can let you know 
about important information via a message bar (colour depends on the 
importance of the message) that appears at the top of the map canvas but 
doesn‟t force you to deal with it if you are busy doing something else. 
Programmers can create these notification (e.g. from a plugin) to using our 
python API. 

 Live colour chooser dialogs and buttons: Every colour chooser button 
throughout the interface has been updated to give visual feedback on whether 
the current colour has a transparent, or „alpha,‟ component. The colour 
chooser opened by the new color buttons will now always be the default for the 
operating system. If the user has Use live-updating colour chooser dialogs 
checked under Options -> General -> Application, any change in the colour 
chooser will immediately be shown in the colour button and for any item 
currently being edited, where applicable. 

 SVG Annotations: With QGIS 2.0 you can now add SVG annotations to your map 
- either pinned to a specific place or in a relative position over the map canvas. 

Data Provider 

 Oracle Spatial support: QGIS 2.0 now includes Oracle Spatial support. 

 Web Coverage Service provider added: QGIS now provides native support for 
Web Coverage Service layers - the process for adding WCS is similar to adding a 
WMS layer or WFS layer. 

 Raster Data Provider overhaul: The raster data provider system has been 
completely overhauled. One of the best new features stemming from this work 
is the ability to Layer -> Save As... to save any raster layer as a new layer. In 

http://www.qgis.org/en/docs/user_manual/index.html
http://changelog.linfiniti.com/version/1/
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the process you can clip, resample, and reproject the layer to a new 
Coordinate Reference System. You can also save a raster layer as a rendered 
image so if you for example have single band raster that you have applied a 
colour palette to, you can save the rendered layer out to a georeferenced RGB 
layer. 

 Raster 2% cumulative cut by default: Many raster imagery products have a 
large number of outliers which result in images having a washed out 
appearance. QGIS 2.0 introduces much more fine grained control over the 
rendering behaviour of rasters, including using a 2% - 98% percent cumulative 
cut by default when determining the colour space for the image. 

 WMS identify format: It is now possible to select the format of the identify 
tool result for WMS layers if multiple known formats are supported by the 
server. The supported formats are HTML, feature (GML) and plain text. If the 
feature (GML) format is selected, the result is in the same form as for vector 
layers, the geometry may be highlighted and the feature including attributes 
and geometry may be copied to clipboard and pasted to another layer. 

 WMTS Support: The WMS client in QGIS now supports WMTS (Web Mapping Tile 
Service) including selection of sub-datasets such as time slices. When adding a 
WMS layer from a compliant server, you will be prompted to select the time 
slice to display. 

Symbology 

 Data defined properties: With the new data defined properties, it is possible 
to control symbol type, size, colour, rotation, and many other properties 
through feature attributes. 

 Improved symbol layer management: The new symbol layer overview uses a 
clear, tree-structured layout which allows for easy and fast access to all symbol 
layers. 

 Support for transparency in colour definitions: In most places where you 
select colours, QGIS now allows you to specify the alpha channel (which 
determines how transparent the colour should be). This allows you to create 
great looking maps and to hide data easily that you don‟t want users to see. 

 Colour Control for Raster Layers: QGIS 2.0 allows you to precisely control 
exactly how you‟d like raster layers to appear. You now have complete control 
over the brightness, contrast and saturation of raster layers. There are even 
options to allow display of rasters in greyscale or by colourising with a specified 
colour. 

 Copy symbology between layers: It‟s now super easy to copy symbology from 
one layer to another layer. If you are working with several similar layers, you 
can simply right-click on one layer, choose Copy Style from the context menu 
and then right-click on another layer and choose Paste-Style. 

 Save styles in your database: If you are using a database vector data store, 
you can now store the layer style definitions directly in the database. This 
makes it easy to share styled layers in an enterprise or multi-user environment. 
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 Colour ramp support: Colour ramps are now available in many places in QGIS 
symbology settings and QGIS ships with a rich, extensible set of colour ramps. 
You can also design your own and many cpt-city themes are included in QGIS 
now „out of the box‟. Colour ramps even have full support for transparency! 

 Set custom default styles for all layer types: Now QGIS lets you control how 
new layers will be drawn when they do not have an existing .qml style defined. 
You can also set the default transparency level for new layers and whether 
symbols should have random colours assigned to them. 

Map Composer 

 HTML Map Items: You can now place html elements onto your map. 

 Auto snap lines: Having nicely aligned map items is critical to making nice 
printed maps. Auto snapping lines have been added to allow for easy composer 
object alignment by simply dragging an object close to another. 

 Manual Snap Lines: Sometimes you need to align objects a curtain distance on 
the composer. With the new manual snapping lines you are able to add manual 
snap lines which allow for better align objects using a common alignment. 
Simply drag from the top or side ruler to add new guide line. 

 Map series generation: The composer now includes built in map series 
generation using the atlas feature. Coverage layers can be points, lines, 
polygons, and the current feature attribute data is available in labels for on the 
fly value replacement. 

 Multipage support: A single composer window can now contain more than one 
page. 

 Expressions in composer labels: The composer label item in 1.8 was quite 
limited and only allowed a single token $CURRENT_DATE to be used. In 2.0 full 
expression support has been added to greater power and control of the final 
labels. 

 Automatic overview support in map frame: Need to show the current area of 
the main map frame in a smaller overview window. Now you can. The map 
frame now contains the ability to show the extents of other and will update 
when moved. Using this with the atlas generation feature now core in the 
composer allows for some slick map generation. Overview frame style uses the 
same styling as a normal map polygon object so your creativity is never 
restricted. 

 Layer blending: Layer blending makes it possible to combine layers in new and 
exciting ways. While in older versions, all you could do was to make the layer 
transparent, you can now choose between much more advanced options such as 
“multiply”, “darken only”, and many more. Blending can be used in the normal 
map view as well as in print composer. For a short tutorial on how to use 
blending in print composer to make the most out of background images, see 
“Vintage map design using QGIS” from QGIS User Guide. 
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 HTML Label support: HTML support has been added map composer label item 
to give you even more control over your final maps. HTML labels support full 
css styles sheets, html, and even javascript if you are that way inclined. 

 Multicolumn composer legend: The composer legend now supports multiple 
columns. Splitting of a single layer with many classes into multiple columns is 
optional. Single symbol layers are now added by default as single line item. 
Three different styles may be assigned to layer/group title: Group, Subgroup or 
Hidden. Title styles allow arbitrary visual grouping of items. For example, a 
single symbol layer may be displayed as single line item or with layer title (like 
in 1.8), symbols from multiple following layers may be grouped into a single 
group (hiding titles) etc. Feature counts may be added to labels. 

 Updates to map composer management: The following improvements have 
been made to map composer management: 

o Composer name can now be defined upon creation, optionally choosing to 
start from other composer names. 

o Composers can now be duplicated. 

o New from Template and from Specific (in Composer Manager) creates a 
composer from a template located anywhere on the file system. 

o Parent project can now be saved directly from the composer work space. 

o All composer management actions now accessible directly from the 
composer work space. 

Labeling 

 New labeling system: The labeling system has been totally overhauled - it now 
includes many new features such as drop shadows, „highway shields‟, many 
more data bound options, and various performance enhancements. QGIS is 
slowly doing away with the „old labels‟ system, although you will still find that 
functionality available for this release, you should expect that it will disappear 
in a follow up release. 

 Expression based label properties: The full power of normal label and rule 
expressions can now be used for label properties. Nearly every property can be 
defined with an expression or field value giving you more control over the label 
result. Expressions can refer to a field (e.g. set the font size to the value of the 
field „font‟) or can include more complex logic. 

 Older labeling engine deprecated: Use of the older labeling engine available 
in QGIS <= 1.8 is now discouraged (i.e. deprecated), but has not been removed. 
This is to allow users to migrate existing projects from the old to new labeling 
engine. The following guidelines for working with the older engine in QGIS 2.0 
apply: 

o Deprecated labeling tab is removed from vector layer properties dialog for 
new projects or older opened projects that don‟t use that labeling engine. 
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o Deprecated tab remains active for older opened projects, if any layer uses 
them, and does not go away even if saving the project with no layers having 
the older labeling engine enabled. 

o Deprecated labeling tab can be enabled/disabled for the current project, 
via Python console commands. Please note: There is a very high likelihood 
the deprecated labelling engine will be completely removed prior to the 
next stable release of QGIS. Please migrate older projects. 

Analysis tools 

 Processing Commander: For quick access to geoprocessing functionality, just 
launch the processing commander (Ctrl + Alt + M) and start typing the name of 
the tool you are looking for. Commander will show you the available options 
and launch them for you. No more searching through menus to find tools. They 
are now right at your fingertips. 

 ‘Heatmap’ Plugin Improvements: The heatmap plugin has seen numerous 
improvements and optimisations, resulting in much faster creation of 
heatmaps. Additionally, you now have the choice of which kernel function is 
used to create the heatmap. 

 Processing Support: The SEXTANTE project has been ported to and 
incorporated into QGIS as core functionality. SEXTANTE has been renamed to 
„Processing‟ and introduces a new menu in QGIS from where you can access a 
rich toolbox of spatial analysis tools. The processing toolbox has incredibly rich 
functionality - with a python programming API allowing you to easily add new 
tools, and hooks to provide access to analysis capabilities of many popular open 
source tools such as GRASS, OTB, SAGA etc. 

 Processing Modeller: One of the great features of the new processing 
framework is the ability to combine the tools graphically. Using the Processing 
Modeller, you can build up complex analysis from a series of small single 
purpose modules. You can save these models and then use them as building 
blocks in even more complex models. Awesome power integrated right into 
QGIS and very easy to use! 

Plugins 

 Revamped plugin manager: In QGIS 1.x managing plugins was somewhat 
confusing with two interfaces - one for managing already installed plugins and 
one for fetching python plugins from an only plugin repository. In QGIS 2.0 a 
new, unified, plugin manager has been introduced which provides a one stop 
shop for downloading, enabling/disabling and generally managing you plugins.  

 Application and Project Options: Define default start-up project and project 
templates. With QGIS 2.0 you can specify what QGIS should do when it starts: 
New Project (legacy behaviour, starts with a blank project), Most recent (when 
you start QGIS it will load the last project you worked on), Specific (always 
load a specific project when QGIS starts). You can use the project template 
directory to specify where your template projects should be stored. Any 
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project that you store in that directory will be available for use as a template 

when invoking the Project ‣ New from template menu. 

 System environment variables: Current system environment variables can now 
be viewed and many configured within the application Options dialog. Useful 
for platforms, such as Mac, where a GUI application does not necessarily inherit 
the user‟s shell environment. Also useful for setting/viewing environment 
variables for the external tool sets controlled by the processing toolbox, e.g. 
SAGA, GRASS; and, for turning on debugging output for specific sections of the 
source code. 

 User-defined zoom scales: A listing of zoom scales can now be configured for 
the application and optionally overridden per project. The list will show up in 
the Scale popup combo box in the main window status bar, allowing for quick 
access to known scales for efficiently viewing and working with the current 
data sources. Defined scales can be exported to an XML file that can be 
imported into other projects or another QGIS application. 

Layer Legend 

 Legend visual feedback and options 

o Total count for features in layer, as well as per symbol. 

o Vector layers in edit mode now have a red pencil to indicate uncommitted 
(unsaved) edits. 

o Active layer is now underlined, to indicate it in multi-layer selections or 
when there is no selection. 

o Clicking in non-list-item whitespace now clears the selection. 

o Right-clicks are now treated as left-clicks prior to showing the contextual 
menu, allowing for one click instead of two. 

o Groups and layers can optionally be in a bold font style. 

o Raster layer generated preview icons can now be turned off, for projects 
where such rendering may be slow. 

 Duplicate existing map layer: Duplicate selected vector and raster layers in 
the map layer legend. Similar to importing the same data source again, as a 
separate layer, then copy/pasting style and symbology attributes. 

 Multi-layer toggle editing commands: User can now select multiple layers in 
legend and, if any of those are vector layers in edit mode, choose to save, 
rollback, or cancel current uncommitted edits. User can also choose to apply 
those actions across all layers, regardless of selection. 

Browser 

 Improvements to in-app browser panel: 

o Directories can be filtered by wildcard or regex expressions. 
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o New Project home (parent directory of current project). 

o View Properties of the selected directory in a dialog. 

o Choose which directories to Fast scan. 

o Choose to Add a directory directly to Favourites via file system browse 
dialog. 

o New /Volumes on Mac (hidden directory for access to external drives). 

o New OWS group (collation of available map server connections). 

o Open a second browser (View -> Panels -> Browser (2)) for drag-n-drop 
interactions between browser panels. 

o Icons now sorted by item group type (file system, databases, map servers). 

o Layer Properties now have better visual layout. 

 

 


